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EXECUTIVE SUMMARY 

Brood stocks were established at two institutes, with 10 animals each to Seahorse World and 
SEA LIFE Melbourne Aquarium. Both institutes are known to have at least one fertile pair 
due to breeding occurring in captivity following collection. The captive population is now 116 
fish (30/12/2017) of which 20 are adults or sub-adults and 96 are captive bred juveniles. No 
fish have died during this process which was unexpected as previously high mortality 
occurred for juveniles. Our use of marine-tank chiller units, which have become cheaply 
available since the previous captive breeding work in the mid-1990s, may be responsible for 
this low mortality. 

Knowledge transfer to industry partners (Seahorse World and SEA LIFE Melbourne 
Aquarium) by CSIRO officers for captive breeding of handfish was made through personal 
visits, phone calls and the provision of all reports and laboratory notes. A standard operating 
procedure was developed for data processing and transfer of animals via freight. A stud book 
was also established - Spotted handfish ambassador fish program: captive fish studbook.  
See References. 

Compared to previous years, similar results were obtained for fish densities at the nine long-
term monitoring sites, however this year the observed decline at Ralphs Bay continued to its 
conclusion with no fish observed during 2017. 
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1. INTRODUCTION 
In 2017 we collected brood stock and transferred animals to our institute partners, and 
continued our performance assessment surveys.  Several manuscripts were also prepared 
and submitted. As major analysis was done in previous reports (Wong and Lynch 2017) this 
is a more technically focused document made up of a small main body and extensive 
appendixes.  

Our capture-mark-recapture work for spotted handfish only identified one recapture across 
2015-2016, based on pattern recognition software.  However, as we are only observing 
between 1-15 fish at each site per year, this is not unexpected even with small populations.  
More intensive studies (Lynch et al. 2015) at Battery Point in 2014 found 3 recaptures from 
38 observations, while another intensive study at Battery Point and Sandy Bay in 2012 
provided enough recaptures to estimate populations of 130 and 72 fish per site (Moriarty 
2012).  If these local population estimates are related to densities, as suggested by Moriarty, 
then with 5 medium density sites (~100 fish), four low density sites (~50 fish) and one high 
density site (~ 200 fish), a minimum population across the 10 sites was estimated to be at 
least 1,000 in 2016. There may be many more fish than this in the wild but, at the moment, 
our best estimate is that this is the minimum number of fish.  Better estimates of total 
populations may be available with more observations and/or genetic work.   

In negotiations with the state government, permitting for sustainable take was limited to less 
than 5% of the total population. Our industry partners suggested that they would like to 
receive 10 fish each, which was considered reasonable based on the estimated minimum 
stock size and genetic diversity.  However, they also advised that a death rate not exceeding 
50% may occur during establishment of the program.  This would mean, as a worst case 
scenario, that we would take 40 fish in total, which would represent >5% of the suggested 
minimum population.   

As handfish are not sexually dimorphic, taking at least 20 fish increased the likelihood of 
acquiring both males and females.  We also collected in September through to November 
2017.  This is the breeding season and sex differentiation was possible in some cases as 
females become heavily gravid, though fish may not breed annually (Green pers comm). We 
took fish across most sites to minimise disturbance to local populations. Our understanding 
of connectivity is that any one population has only recently (late 20th century) been 
fragmented (Lawler 1999), so we hypothesise isolated local populations are similar genetic 
stock. Again, as with the population estimate, more modern genetic studies could test this 
hypothesis. 

The project aims to provide conservation through the aquarium community sustaining ex situ 
populations of spotted handfish This will be done in conjunction with a well-established 
program (funded by the National Environmental Science Program and CSIRO), industry 
partners Seahorse World and SEA LIFE Melbourne Aquarium, as well as through surveys, to 
establish trends in fish abundance at multiple sites through time. To this end we: 
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1. captured fish for commercial aquariums, based on estimates of the minimum 
population 

2. settled and conditioned fish for short periods of time before transfer to aquariums 

3. facilitated knowledge transfer of CSIRO’s previously developed husbandry and 
breeding techniques to two different institutions, SEA LIFE Melbourne Aquarium and 
Seahorse World 

4. raised the profile of the spotted handfish with the broader community through the 
ambassador fish program, media, talks, outreach, publications and interpretation 
materials 

5. had facilities on hand to receive and settle captive bred fish for release back into the 
wild if required 
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2. SURVEYS  

Surveys were planned using the NESP developed spatially balanced sampling procedure 
(Foster et al.), which took into consideration previous transects. Density surveys were 
completed prior to the start of the September 2017 breeding season with 8 transects 
conducted at each of the 9 long term monitoring sites.  Data collection and work flows are 
now well established with an Access data base replacing the previous Excel spreadsheet.  A 
standard operating procedure (SOP) for the data workflow is now also available (Appendix 
A). Results were similar to previous years (Lynch et al. 2016) for site densities (Fig 1). 
Consistent with an exponential decline observed in previous years, no fish were observed at 
Ralphs Bay in 2017.  

 

Figure 1 Density estimates for spotted handfish at 9 long term sites in 2017 (BP = Battery Point, BR = Bellerive, 
HMB = Half Moon Bay, HB = Howrah Beach, MAB = Mary Anne Bay, OP = Opossum Bay, RB = Ralphs Bay, SB 
= Sandy Bay, TR = Tranmere. 
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3. BROOD STOCK 
As advised by the Handfish Recovery Team (HRT) geneticist, Dr Carolyn Hogg, brood stock 
were collected from all known sites within the Derwent, with the exception of Ralphs Bay 
(Table 1). Details and photos of all fish are recorded in the stud book (Appendix B). 
 
Fish were collected by hand, initially using a dip net but then by just opening the perforated 
collection jar (Fig 2) and gently shuffling the fish into the mouth with the lid.  This proved to 
be much less stressful to the fish. Collection containers and fish were held in a dive bag for 
the remainder of the dive. At the end of the dive, fish and containers were transferred while 
underwater into the larger bucket and transported to the surface. This was so fish remained 
in water when moved from the water into the boat.  Once the divers were brought back into 
the boat we made a fast trip back to CSIRO where another officer would be waiting to swiftly 
transfer fish into the holding facility. If time permitted we would then travel to a new dive site 
to collect more fish. 
 
 
 
Table 1 Brood stock collection region, site and distribution to institutes 

Region Site Total number # Seahorse 
World 

# SEA LIFE 

     
Western Battery Point 3 1 2 
 Sandy Bay 5 3 2 
     
South Arm Mary-Ann Bay 5 1 4 
 Half Moon Bay 1 1  
 Opossum Bay 2 2  
     
Eastern Bellerive Beach 2 1 1 
 Tranmere 1  1 
 Howrah Beach 1 1  
     
TOTALS  20 10 10 
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Figure 2 Collection equipment 

 
We collected all fish we saw on collection dives with the exception of fish guarding eggs.  
This may have resulted in a bias for males but we are certain that each institute has at least 
one fertile pair as two pairs of fish bred in captivity. 
 

3.1 Aquarium holding facility and captive breeding 

Captive husbandry and release of individuals for both red and spotted handfish has occurred 
in the past (Green and Bruce 2000, 2002).  The previous project, however, was mainly for 
research and methods development. The main difference to the current project is that CSIRO 
will only be a staging area for fish. They will then transfer the animals to large-scale 
commercial aquariums.  These institutions have provided in-kind commitments to keep fish 
through to 2020. However, as they do not have business models dependent on short-term 
competitive granting, but rather will use the fish as a business assets, the captive populations 
may persist well into the future. We think that this change in approach will allow for fish to 
become self-sustaining as captive populations with surplus individuals available for re-
stocking back into the wild.     

A custom built facility was commissioned at CSIRO to hold and condition the fish prior to 
transfer to the partner institutes (Fig 3). 
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Figure 3 Mr Tim Fountain and the handfish holding facility during commissioning 

The set-up of the facility is: 

Large holding tanks (160cm X 58cm X60cm) (~550 litre) 

2 x 25 Watt Emperor Aquatics UV sterilisers for water 

2 x PPS05 Aquasonic water fractionator to remove wastes and slimes 

4 x Tanks 40cm X 40cm X 40cm (~ 60 litre) (conditioning tanks) 

2 x Multi 4000 water pumps  

2 x HC-300A Hailea Chiller units 1/4hp  

2 x ABS25 Bio Filter Sump w/25L Media  

Air pumps to work directly off CSIRO building supply  

2 x Aqualina multi-channel blue tooth programmable lights to simulate day/night conditions 

Once commissioned (Fig 4), the flooring in the holding tank was stocked with natural 
substrates taken from handfish habitat.  We set up this tank to replicate the environment and 
provide enrichment by using photographs pinned to the tank glass and objects for the fish to 
hide behind. The programmable light system replicated the diurnal patterns and lux of the 
natural environment. 
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The system is designed to remain full of water even if power is cut, through the use of stand 
pipes in the tanks.  Power is monitored 24/7 and alarmed with a call out facility.  The main 
risk is overheating which was mollified by the use of the chillers and a separate air 
conditioning unit in the small windowless, internal and well insulated room. 

 

Figure 4 Commissioned facility with lights  

One pair of fish bred in CSIRO’s holding facility (BP-001 and BP-002) soon after collection, 
as did another pair (OP-001 and OP-002) at Seahorse World soon after transfer (See Stud 
Book Appendix B). The BP breeding pair were sent to SEA LIFE Melbourne Aquarium.   

Fish were fed live food (amphipods) collected 2-3 times per week from the Kingston Beach 
boat ramp (Fig 5).    
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Figure 5 Collection apparatus and site for live food. 

Water quality parameters for the tanks were taken near daily and were cross checked 
against natural conditions.  
 
At CSIRO, photographs were taken of the eggs developing (Appendix C). When the eggs 
began to hatch we quickly transferred 15 juveniles to Seahorse World (within 24 hours) (Fig 
6) and then released the remainder back near where the adults were collected at Battery 
Point. These were later joined by 81 juveniles that hatched at Seahorse World.  Unlike 
previous studies, incubation was longer ~10 weeks compared to 6-8 with few un-hatched 
eggs.  This may be due to better water quality provided by the chiller units and other tank 
features such as skimmer units. 

 
 
Figure 6 The 15 captive breed fish from CSIRO after delivery to Seahorse World. 

Fish were despatched to institutes in batches of 4-5 fish across 2-3 packing events to 
minimise the risk of death of brood stock due to a catastrophic transport mishap. Packing 
and dispatch of fish was a technical process and this is detailed in Appendix D.  
 
No fish were lost during capture, breeding, transfer or since the fish have been accepted by 
the institutes (30/12/2017). This was unlike the previous study and was unexpected.
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APPENDIX A – SOP FOR DATA HANDLING 
Handfish survey data entry/processing standard operating procedure 
Software requirement 
Holux ezTour for data logger 
Microsoft Access 
R or Rstudio 
BR’s EXIFextracter 
 
1.0 Introduction 

1.1 Outcome 
This document outlined the procedure required to extract field data collected during each GUCV 
search data from GPS and camera’s SD card for processing and converting data into a csv file for 
later analysis. 
 

1.2 Intro 

During each handfish search, two set of data are recorded:  
1. a GPS track of the dive team’s location, recorded using a GPS towed on a surface float; and  
2. time stamped photos of handfish or other points of interest captured using an underwater 

camera which is synchronised with the GPS clock, used for post-hoc georeferencing specific 
points (e.g. start/end of each search, and location of sighted fish).  

 
As the data were processed, specific information will be extracted, essential for handfish 
population analysis. Two primary file will be generated, first included metadata of each transect 
conducted and the second recorded the data of each individual handfish sighting. Data entry and 
the storage of data were completed with a Microsoft Access database. 
 

2.0 Downloading data 
2.1 GPS track 
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1. Connect Holux GPS to computer via a micro USB 2.0 cable 

 
2. Open Holux exTour for data logger 

Box 1 
For first time setup, the software will ask for a product identification code and an email address 
to activate the software. The code is located on the back of the GPS units used for the handfish 
project. 
It is possible after connecting the GPS to the computer, the software will indicate that it failed to 
connect or detect the GPS. This is most likely due to a driver issue. When first setting up the 
computer for using this Holux ezTour program, ensure that the driver for Silicon Labs CP210x USB 
to UART Bridge is up to date. 
It is possible the computer did not recognise the new driver required (Silicon Labs CP210x USB to 
UART Bridge) as a COM port, thus failed to connect with the GPS. When first connected the GPS 
to the computer, open Device Manager from the computer (Click start and search for Device 
Manager) and check if “Silicon Labs CP210x USB to UART Bridge” become visible under the Ports 
(COM & LPT) list 

  
If the driver is not in the list, it is possible the driver was hidden under Other devices as an 
unknown device. Right click on it and select “Update driver software”. The system will search for 
update for the driver automatically and once finished, may require a reboot. Once this step is 
completed, the driver should be in place and allowed for the GPS to be connected. 
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a) Spatial view panel/ track visualisation 
b) Track, photo information panel 
c) Metadata panel for track/photo 

 
3. Click File->Read GPS device log 

 
4. Select Read log only and click OK 
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5. Select track(s) of interest and click OK 

 
6. Save project 
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7.  as: *Date(yyyymmdd)_RAW* 
e.g. 20170525_RAW 

 
at this directory  
My computer 

└ Public (P:) 
 └ Tim_Lynch 
  └ *HandfishData_year* 
   └ *Date (yyyymmdd)* 

└ * 
*create new folder when necessary (e.g. new survey year and new survey dates)* 

 
2.2 Photo 

1. Insert Camera’s SD card via card reader 
2. Sort photo base on date taken 
3. Select photos of interest and copy 
4. Save to folder: *Handfish_photos_All_year* 

e.g. Handfish_photos_All_2017 
 
at this directory 
My computer 

└ Public (P:) 
 └ Tim_Lynch 
  └ *Handfish_photos_All_year* 
   └ * 
*create new folder when necessary (e.g. new survey year and new survey dates)* 

 
 
3.0 Extracting transect for GPS track 

3.1 Import geotagged photo 
1. Open the file Date(yyyymmdd)_Site_RAW 
2. Click Photo/Media -> Add Media Files -> From Files 

 
3. Navigate to the photo folder (*Handfish_photos_All_year*) 
4. Select photo taken on the date of the transect 

  



APPENDIX A – SOP FOR DATA HANDLING 

 

 

 
 
 
Procedures and methods for establishment of captive breeding populations of spotted handfish    Page | 15 

 

 
5. Click Open 
6. Inspect track and location of photos 
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7. Inspect the track and photos (camera icon) 
 

Box 2 
Normally, the section of the GPS track related to the dive will have a “c – shape”, with photo 
present throughout the track. While the actual coordinate of the photo taken can varies due to 
field limitations, the coordinates of start/end of transect photos (“finger photo”) should be 
distributed in a logical fashion (i.e. close to the corner of the track). The photos should separate the 
track in to 3 sections (2 long tracks, approximately the same length corresponding to the transect; 1 
short track, recording the randomised swim) 

 
If the start/end transect photo does not line up, it is possible the timestamp on the camera did not 
line up with the GPS.  If required all photos imported into the program can be shifted a set amount 
of time to line up the GPS track and the captured photos. Alternatively, if the error was caused by 
daylight saving time (1 hour shift), the button can also be checked to change the GPS time. 
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3.2 Geotagging photo 
1. Click Photo/Media-> Write GPS Info into Photos 

 
2. Select Photo List Panel 
3. Confirm “V” or “” present in in the Geo Tagged column 

 
4. Save file as: *Date_Site_DiveNumber* 

e.g. 20170525_HB_D3-6 
 
My computer 

└ Public (P:) 
 └ Tim_Lynch 
  └ HandfishData_*year* 
   └ *Date (yyyymmdd)* 
    └ *Date_Site_DiveNumber* 
 
*create new folder when necessary (e.g. new survey year and new survey dates)* 

 
 

3.3 Extract transect from GPS track 
1. Select the Photo List panel 
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2. Locate photo marking start/end of each transect 
3. Make note of capture time on date column 

 
 

4. Go to Track Editor  
5. Zoom in to the track (Scroll wheel function disabled) using the zoom (“+”,”-“) 

buttons 
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6. Trace along the track and examine the log’s detail for the record time 

 
7. Find the reference point of the track near the capture time of reference photo 

(“finger photo”) 

 

The track is composed of GPS log recorded once every 5 seconds, the details are hidden within 
the track normally, however when tracing along the track, the cursor will snap to the nearest log 
and highlight the detail of that specific point, including the captured date and time of the log.  
Based on the captured time information of transect start/end photos (“finger photos”), and their 
position along the track, the GPS track can be trimmed at specific times (as close to the capture 
time) to identify the section of the track which represented a handfish transect. 
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8. Right click on the point 
9. Select split track 

 
10. Repeat process for all reference photos (4 per dive) 

 
 

 
 
 

3.4 Delete additional/ trash sections of track 
After splitting the track based on the start and end point of each transect, sections of GPS tracks 
not related (e.g. traveling time between sites and start point) still remain in the file. This section 
describes the process to remove these tracks. 

1. Select Track List panel  
2. Identify tracks not representing search transect or “trash track” 

Box 3 
As the Holux ezTour for data logger requires communication with external server from Google 
Maps, an error message (below) will constantly pop up. To resolve this, press escape to close 
down the pop up and switch to track editor view. 
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Usually starting with the first one and every other one  
Check the track properties for trip distance, non-transect usually have very long (600m 
– kms) or very short recorded distance (10m – 30m). 

3. Select the non-transect track 
The software only allowed one track to be delete at a time 

4. Click remove 

 
5. Repeat for all non-related section (Surface transverse time, Period between transects) 

 
 
4.0 Extract photo geolocation 

While spatial information is written into each photo after the geotagging process, the program 
does not allow for such metadata to be extracted in a meaningful way for this project (only 
allowed for export as KML file or webmap format). Thus a metadata extractor was used to 1) 
extract data in batch; and 2) extract data in flat file format for storage and further manipulation. 
 

4.1 Extracting metadata 
1. Open BR’s EXIFextracter 
2. Select folder to scan as: P:\Tim_Lynch\*Handfish_photos_All_year*\ 
3. Select Output filename: 

P:\Tim_Lynch\Handfish_Data_analysis\Photo\*year_HF_Photo_Coor* 
4. Check “Date”, ”Time”, “Latitude”, “Longitude” at the Select Data panel 
5. Select Separator character as “,(comma)” 
6. Click Extract 
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4.2 Modifying data format 
This script will select the extracted file (in csv format) and convert the format that lines up 
with the Access database in order for the coordinates to be imported into the database. 

1. Open R or R studio 

2 
3 

4 

5 

6 
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a) Script panel 
b) Work directory 
c) Console panel 
 

2. When installed the first time, the additional package “chron” needs to be download first 
3. In the console panel, type install.packages(“chron”) 

 
4. Open PhotoCoor_db_script.R at: P:\Tim_Lynch\Handfish_Data_analysis\ 
5. Highlight and run script by hitting Control+Enter 

 
 
When the script is finished, it will automatically close RStudio. The new output is called 
“*Year*_HF_Photo_Coor_out.csv” which is located in the same directory 
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5.0 Input data 

5.1 Handfish data 
1. Open Handfish Access database at: 

P:\Tim_Lynch\Handfish_Data_analysis\Handfish_150817_LW.accdb 

 

*Note: for data organisation and reducing processing time, it will be best to separate photos 
based on survey year. Thus at the beginning of each survey year (or first data processing session 
each year), the directory of both BR’s EXIFextracter and the R script need to be modified. 
 
For BR’s EXIPextracter, the file directory needed to be changed as follows: 

 
For the R script, the input needs to be the same as the name of the output from BR’s 
EXIFextracter in order for the code to work. Thus with a new dataset, the script need to change 
as follows: 
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2. When first loading up the access database, click File-> Security-> Enable all content. 
Double click on the form F_DataEntry_New on the object panel (left) and a new window 
will pop up 

 

 
3. Fill in detail of each search 

3.a UVC date 
3.b Surveyed site 
3.c Number of diver 

4. Fill in dive number refer to the start point (may not be sequential) 
Dive number correspond to the list of coordinates generated randomly using the spatially 
balance model. Field survey may not necessarily follow the list sequentially due to dive 
safety etc. Thus conformation of dive number will be required between field notes and 
projected coordinates from data 

 
5. Fill in transect number 

Transect number for first transect of dive = (dive no *2) -1 
e.g. if dive no = 5 
1st transect = (5*2)-1 = 9 
2nd transect = 9+1 = 10 

 
6. Fill in detail of transect, located in processed GPS file (Step 2.4) 

6.a Transect start time 
6.b Transect end time 
6.c Transect length 

7. Fill in Sighted fish section 
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7.a If no fish were sighted, leave Sighted fish section empty 
7.b If fish were present, fill in the detail 

8. Fill in total length, sighted depth, and stress response 
9. Fill in the sighted time of each fish from the Holux file (first photo of the handfish 

encounter)  
A common variable is required to cross reference photos taken for each individual fish to the 
correct record of the individual fish. Time of sighting was used as it allowed the database to 
automatically shortlist the photos corresponding to each sighting. While the list only correspond 
to a portion of photo taken for each fish, it allowed for easier distinguishing of fish from the 
entire list.  

9.a Go to Photo List panel  
9.b Find the photos of each sighted fish 
9.c Identify the capture time of first photo 
9.d Do not round up times, ie 12:33:59 = 12:33 

 
10. Fill in the Sighted_DateTime field (format: dd/mm/yyyy hh:mm) 
11. Repeat for all fish sighted within the transect 
12. Click Save 
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13. Makes notes if not for density analysis (e.g. collection of fish, ASH survey etc) 
14. Click New Record to enter data for next transect 
15. Close pop-up when finish data entry 
 

5.2 Importing metadata for geotagged photo 
1. Open Handfish Access database at: P:\Tim_Lynch\Handfish_170517_LW.accdb 
2. Click External Data->Saved Imports 
3. Run PhotoCoor_import 

Common error messages include: key violation (due to NA and overwriting) and failure to run (target 
files are open). A solution is to close files and remove NA.  You can also try deleting data (after saving 
a copy of the database) from the Access table and then re-importing 
 
6.0 Export data for analysis  

1. Click EXTERNAL DATA-> Saved Exports 
2. Run Export_transect_data 
3. Run Export_HFObs 
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Data analysis 
 
 
7.0 Processing transect and sighted individuals for density analysis 
See appendix 2 for R script 
 
8.0 Processing individual photos 

The aim of this section is to further separate the data to individual level 
8.1 Setting up I3S pattern 

1. Open I3S Pattern 
2. When prompted set database to: P:\Tim_Lynch\I3S_Spotted_Handfish 

 
8.2 Setting up Access Database 

1. Open Handfish Access database at: P:\Tim_Lynch\Handfish_170517_LW.accdb 
2. Open form F_Indv_Photo_Search listed in the object panel (left) 
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8.3 Selecting photo for analysis 
1. Open window explorer to directory for captured photo (e.g. 

P:\Tim_Lynch\*Handfish_photos_All_2017*) 
Preferred setup for this process will be with dual/triple monitor, with I3S, Access, and list of 
photo showing simultaneously. 

 
2. Click the Last record button under the “I3S comparison result” section in Access. This 

highlighted the last observation that was analysed 

The form F_Indv_Photo_Search fulfilled two primary roles. Firstly, this form provided an 
interface to select and examine data collected for each individual observation (left). In particular, 
it provides a list of photos taken during each observation. The highlighted photos represented 
the first few photos taken of the individual. 
 
The second role this form is to provide an interface to log the pattern analysis conducted 
through I3S pattern (Right). This form is linked to a new table (tblHandfishID) which introduced a 
new variable: HF_ID. This variable is an unique identification number for individual fish sighted.  
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3. Click the find button under the “Individual handfish observation record” section 

 
 

4. In the find what field, type the latest Fish Obs ID (Should be identical to Current HF_ID 
count) 

5. Select the next record in the individual handfish observation record (This will be the next 
observation that has not been analysed) 
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6. Using window explorer of Handfish_Photos_2017, preview the list of photo for the highest 
quality photos of the handfish observation 
 

7.2 Analysis photo with I3S 
1. Open the photo in I3S Pattern by click File-> Open image 

 
 

2. Navigate to the directory where all photos were stored (e.g. 
P:\Tim_Lynch\Handfish_photos_All_2017) and select the photo for analysis 

 

Photos with the turtle icon  indicated a photo fingerprint is available, suggesting 1) 
comparison was completed and individuals was registered in the tblHandfishtable, or 2) a 
fingerprint was constructed and saved but analysis was not completed.  

On the other hand, photos with  icon have not been processed with I3S pattern yet. 

3. Toggle edit mode on by clicking the   icon 
4. Create fingerprint by first selecting the reference point. 
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5. Trace along the front of the fish body to highlight the area of interest for I3S to construct 
the pattern fingerprint automatically  
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6. Select the metadata field by clicking the   icon 
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7. Select site information and the side of the fish the photo captured. As all other information 

is recorded in the database, the other fields can be ignored 
8. Select Database-> Search in database to begin comparison with other entries. Refine the 

selection by selecting entry of photos taken of the same side. 

 
 

 
 

9. I3S Pattern automatically compares the fingerprint of each photo and generates a score 
based on the similarity of the two and sort the database by level of similarity. The lower 
the score, the more similar they are. 

10. Examine manually to determine if observations were of the same individual for the first 3-4 
matches. 
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11. Click Visual comparison for detail examination/comparison of individual 
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7.3 If observation was a new fish 
1. If individual does not match any known fish, click New individual 

 
2.  Create a new ID for the new fish by inserting a database location. 

 
The ID should follow the following naming convention 
Fish_newID_photoside 
e.g. Fish_36_Left 
 
To ensure the new ID is unique, consult the Current HF_ID count text box in the 
F_Indv_Photo_Search form, which show the highest HF_ID recorded in the system. Thus the 
new ID should be 1 above the printed number 

 
 
3. Check rename file in the Naming of the file section 
4. Change the name of the record to reflect the observation number 

The name should follow the following naming convention 
Obs_ID_Photo_no_Photoname 
e.g. Obs_169_Photo_1_DSC03952 
 
The observation id identifies which handfish observation this photo was from. The Photo 
number indicate how many photos of the same observation was analysed. The photo name 
is the original name of the photo, serves as a unique identifier  
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If the fish is a new individual, the Observation ID and HF_ID should be identical 
 

 
 

5. Click Ok 
6. Select No when prompted if you want to rename the original file as well 

By selecting no, this will not change the name of the input. As we are working directly from 
the photo storage on the P drive, changing the name of the photo can cause version 
discrepancy between the Access database and the files (This can be resolved by running 
the extracting metadata section and importing it to the database again). Thus to minimise 
confusion, the input file should remained unchanged. 

 
 

7. Return to the form F_Indv_Photo_Search and click New in the I3S Comparison result 
section, for each observation analysed. (note: all photos analysed for the fish sighted at the 
same time are considered as the same observation) 
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8. Input the observation ID and the newly identified Handfish ID in the corresponding boxes 

in the I3S Comparison result. Also record the number of photos of each side of the fish 
analysed 
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9. Click Save Record to save the new entry 
7.4 If observation was a recapture (use this procedure if a second photos was analysed for the 

same fish) 
1. After visual inspection, if individual was a recapture, click Include in database 

 
2. The new photo will be placed in the same folder as the matched entry in the database. 

Click rename file an generate a new file name for the image 

 
In the file name, identify the observation ID of the photo, the sequence of photo analysed 
for the observation, and the name of the original file (default). 

3. Click Ok to save 
4. Select No when prompted if you want to rename the original file as well 

 
5. Return to the form F_Indv_Photo_Search and click New in the I3S Comparison result 

section, for each observation analysed. (If image processed was a second image of the 
same observation, go back to the original entry using the navigation buttons ) 
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6. Input the observation ID and the newly identified Handfish ID in the corresponding boxes 

in the I3S Comparison result. Also record the number of photos of each side of the fish 
analysed 

 
7. Click Save Record to save the new entry
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SOP Appendix 1: 
R script for structuring data 
(***remember to change years and directories as required***) 
 
setwd("P:/Tim_Lynch/Handfish_Data_analysis/Photo") 
require(chron) 
df<-read.csv("2017_HF_Photo_Coor.csv",na.strings = "") 
names(df)<-c("PhotoNames","Date","Time","Latitude","Longitude") 
df$Sighted_DateTime<-chron(date=as.character(df$Date),time=df$Time, format=c("y:m:d","h:m:s")) 
df$Sighted_DateTime<-format(as.POSIXlt(df$Sighted_DateTime,tz="UTC"), "%Y/%m/%d %H:%M") 
drop<-c("Date","Time") 
df<-df[,!(names(df) %in% drop)] 
write.csv(df, file="2017_HF_Photo_Coor_out.csv",row.names = FALSE) 
q(save = "no")
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SOP Appendix 2 
R script for processing transect and handfish data into density 
 
# import library 
require(dplyr)   #for count and groupby 
require(ggplot2)    #for plotting 
require (agricolae) 
require(multcomp)        #required for GLM posthoc 
 
setwd("P:/Tim_Lynch/Handfish_Data_analysis") 
 
#Import transect 
HFTran<-read.csv("Output/HFTran.csv",na.strings=c("NA","")) 
#Import Handfish observation 
HFObs<-read.csv("Output/HFObs.csv",na.strings=c("NA","")) 
##Discount transects## 
HFTran$Dive_no[HFTran$Dive_no == 0]<-NA 
HFTran<-HFTran[!is.na(HFTran$Dive_no),] 
#Seperate data by year 
date<-as.Date(HFTran$Date,"%d/%m/%Y") 
date<-format(date, format="%Y") 
HFTran<-mutate(HFTran,Year=date) 
#count the number of handfish sighted 
##Make sure column in both file have the same name 
HFSighted<-count(HFObs,Transect_ID) 
 
HFTran$Site_C<-HFTran$Site 
levels(HFTran$Site_C)<-c("BP","BR","FB","HMB", "HB", "MAB", "OP", "RB", "SB", "SP","TR") 
 
#Generate density estimate 
HFdensity<-merge(x=HFTran,y=HFSighted, by.x = "Transect_ID", all=TRUE) 
HFdensity$n[is.na(HFdensity$n)]<-0 
HFdensity<-mutate(HFdensity,nHa=(n/Swath.area)*10^4) 
HFdensity<-HFdensity[complete.cases(HFdensity["Dive_no"]),] 
 
####ANALYSIS FOR DERWENT ONLY#### (**** first lines remove non Derwent sites SP, FB) 
HFdensity<-HFdensity[!HFdensity$Site_C %in% c("SP","FB"),] 
HFdensity<-subset(HFdensity, HFdensity$Year == 2016) 
 
##GLM from Spoon 
d<-HFdensity 
 
fit <- glm(n ~ Site_C+offset(log(Swath.area)),family=poisson(),data=d) 
summary(fit) 
opar <- par(mfrow=c(2,2)) 
plot(fit) 
anova(fit,test="Chi") 
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mc <- glht(fit,linfct=mcp(Site_C="Tukey")) 
summary(mc) 
tab <- confint(mc) 
tab 
exp(tab$confint) 
 
d.pr <- data.frame(Site_C=unique(d$Site_C),Swath.area=1.0E4) 
pr <- predict(fit,d.pr,se.fit = T,type="link") 
d.pr$Density <- exp(pr$fit) 
d.pr$Lower <- exp(pr$fit-2*pr$se.fit) 
d.pr$Upper <- exp(pr$fit+2*pr$se.fit) 
d.pr 
 
denglm<-ggplot(d.pr,aes(x=Site,y=Density,ymin=Lower,ymax=Upper))+geom_pointrange() 
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APPENDIX B – PHOTOS OF DEVELOPING YOUNG 
 

 
Rose, gravid with eggs, settling into the tank the day she was captured. Credit: Carlie Devine, 
CSIRO 
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Rose laying her eggs to days after capture. Credit: Carlie Devine, CSIRO 
 

 
3 week old spotted handfish, located at Seahorse World, Beauty Point, Tasmania.  
Credit: Carlie Devine, CSIRO 
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3 week old spotted handfish, located at Seahorse World, Beauty Point, Tasmania.  
Credit: Carlie Devine, CSIRO 
 
Daily digital capture of the growth of the egg mass began after spotting one egg had turned 
blue on the 25th September 2017. While the egg mass was clearly visible in the tank the most 
effect method of monitoring its health was to take a high resolution digital photograph, upload 
the photograph and zoom into the image at 100 per cent. While it was not possible to see all 
eggs in one photograph, the high resolution image showed about 50 per cent of the mass.  
A Nikon D810 digital camera, a Nikon 60mm prime lens and a 128GB San Disk SD card were 
used for image capture. The Nikon D810 camera has 36 megapixels, a CMOS Sensor, and 
7360 pixels on the long side. The large number of pixels allows for tight cropping when the 
camera can’t get close to the subject. The camera’s pop up flash was used to brighten the 
image and freeze the frame. Image capture settings were 1/80th second shutter speed, ISO 800 
to bring in more natural light, and f8 for a large depth of field.  
 
The camera lens was placed directly flat onto the glass of the tank and auto focus was used for 
ease of shooting. The egg mass was approximately 20cm away from the tank glass and the 
camera. Captured images were uploaded and opened in Adobe Photoshop CC 2017 and were 
colour balanced, sharpened and cropped for best viewing of the egg mass and then saved as a 
high resolution tiff file at 300dpi.   
 
A total of 17 days were digitally captured using the Nikon D810, from the 25th September 2017 
to the 8th November 2017. It was not possible to take a high resolution digital image every day 
due Rose being in between the egg mass and the camera, or other field work commitments 
and weekends. Leaving the camera on a tripod to take a photo automatically was not 
convenient due to the daily tending of the tank by staff. However, the eggs developed slowly 
and all changes were digitally captured.  
 
For much of the period between spawning, 13th September 2017, and the 25th September 2017, 
the day a blue egg was spotted, the eggs did not visually change, they were all white and 
growing within their individual sacks incrementally. An egg turned blue overnight and there was 
discussion as to whether it might be possible to surgically removed the egg from the egg mass 
however, employing high resolution digital capture, it could be determined that it looked to be 
contained in the egg sack and was no threat to the egg mass.  
 
The ascidian came out of the substrate three times and was easily planted back in without 
disruption to the egg mass. The first time the ascidian was replanted three eggs from the other 
side were found to be yellow and did not develop. It is assumed these yellow eggs did not 
survive much past the spawning event.  
 
The first visible growth change was the blacks of the eyes noticed on the 17th October 2017. On 
the 25th October 2017, a yellow speckle of the eyes appeared and each day from then on the 
animals would move about the sack from one day to the next. This movement was not visible to 
the eye but was noticed by comparing one day’s image to another’s. By the 30th October 2017 
it was evident that the bodies were almost fully formed and were popping out of the white of the 
egg interior. A week before the eggs began to hatch the high resolution capture showed fins, 
heads, eyes and tails all very clearly.  
 
The use of high resolution digital capture proved successful in capturing the health of the egg 
mass and the timeline of individual egg growth. Digital photographs are quick, useful tools for 
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seeing what the eye can’t physically see close up, in this case, a moving subject in sea water 
behind glass. The images also proved useful in garnering public interest and awareness with 
regular posts on social media of the growing egg mass. 
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APPENDIX C – TRANSFER PROTOCOLS 
Timing of logistics and packing fish was an important consideration to reduce the risk of 
mortality. The pack has to be done swiftly and immediately before transport with well organised 
transfers (car and/or plane and pick-ups). 
 

 
 
Thick plastic bag lined polystyrene foam box held the double smaller bags that are to contain 
the fish. Cool tank water was placed into each bag and oxygen loaded for 1 minute with the 
help of a bubbler. For the first bag we checked for oxygen saturation with a DO probe with our 
YSI Professional Plus (Pro Plus) instrument. 

 
 



APPENDIX C – TRANSFER PROTOCOLS 

 

 

 
 
 
Procedures and methods for establishment of captive breeding populations of spotted handfish    Page | 52 

Capture of fish from tanks was by dip net and into beakers before transfer, with ample water 
into the oxygen enriched seawater of the double bags. 

 

 
 
Further oxygenation of bags with fish inside the bag then occurred. 

 

 
 
Bags were twisted, secured with rubber bands, then secured again. 
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We transported 4-5 fish in each shipment, if required to keep fish snug we added extra bags of 
water. 

 

 
 

Additional oxygen was added to the larger plastic bag.  
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The larger plastic bag was then secured. 

 

 

A newspaper added for insulation. 
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Four thin freezer packs were then added. 

 

 

The lid was added and taped and, in the case of the transfer to Melbourne paperwork attached 
(consignment note, export permit, import permit). 
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Further labelling and weighing at the airport. 

 

Jet pack kept the fish inside the air-conditioned office prior to loading onto the plane and kept 
us updated on delays. 
 
For all transfers fish arrived alive and well. For transfers to Melbourne parameters were similar 
to the holding tanks upon unpacking.
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